CHAPTER 1

Introduction to Mathcad

Mathcad is a product of MathSoft inc. The Mathcad can help us to calculate, graph, and communicate technical ideas. It lets us work with mathematical expressions using standard math notation - but with the added ability to recalculate, view, present, and publish with ease, even to the Web. We shall explore the following functionalities provided by Mathcad,

- Numeric operators perform summations, products, derivatives, integrals and Boolean operations.
- Numeric functions apply trigonometric, exponential, hyperbolic and other functions and transforms.
- Symbolics simplify, differentiate, integrate, and transform expressions algebraically.
- Vectors and Matrices manipulate arrays and perform various linear algebra operations, such as finding eigenvalues and eigenvectors, and looking up values in arrays.
- Differential Equation Solvers support ordinary differential equations, systems of differential equations, and boundary value problems both at the command line and in solve blocks that use natural notation to specify the differential equations and constraints.

In this chapter, we give a brief introduction to its user interface and the basic usage of MathCad in defining, evaluating, and graphing of variables and functions.
1. User Interface: Menus and Toolbars

Since MathCad is a window program as shown in the following screen shot after run the Mathcad program.

![Mathcad Window](image1.png)

**Figure 1. Mathcad Window**

The blank area is the **work area** that allow us typing and evaluating mathematical expression, graphing, symbolic computing, entering and running Mathcad scripting codes, and entering ordinary text.

It has standard **main menu bar** at the top of the window as most window programs do that is shown in the following screen shot.

![Main Menu Bar](image2.png)

**Figure 2. Main Menu Bar**

But some menus deserve a little more attention. They are **View**, **Insert**, and **Symbolic** menus.

1.1. **The View Menu.** The **View** menu, among other features, allows a user to bring up popup menu bars for using with Mathcad.
Mathcad has nine popup toolbars that for entering math formulas, mathematical symbol, graphing, programming, etc. We can choose to bring up each one at a time or bring up the top level popup menu toolbar by selecting Math as shown in the following screen shot,

By click each menu icon at this top level menu bar, we can bring each individual one as needed.
Practice

(1) Start the Mathcad program and explore it top menu system by click on each menu item.
(2) Bring up the Math popup menu toolbar, move mouse over each icon to see the caption.
(3) Click each icon of the Math popup toolbar to bring up other popup toolbars and explore them.

1.1.1. Graph Toolbar. The graphic toolbar contains toolbars for creating 2D-graph and 3D-graph that are most useful for our purpose.

First click on any blank spot in the work area, which tells Mathcad where to place the graphic region; then click on the icon

or type [Shift][2]( @ sign) Mathcad creates a 2D graphic region at the selected location that can be used to graph any equation $y = f(x)$ or vector pair $\{Y, X\}$. We will give examples to illustrate how to graph functions and vector pair in later section.

1.1.2. Vector and Matrix Toolbar. The Vector and Matrix Toolbar contains toolbars for creating and manipulating matrices.

Figure 5. Graph Toolbar

Figure 6. Vector and Matrix Toolbar
The most frequently use menu selection in the matrix popup toolbar is the create matrix icon,

which upon click will bring up a dialog box that allow us to create a matrix with specified number of rows and columns. Another way to bring up the matrix creating dialog box is press [Ctrl][M] (hold [Ctrl] key and press [M] key)). **Matrix with one row or column is a vector.** The matrix popup toolbar also contains menu selections that help us to find eigenvalues and eigenvectors, to access each individual row or column, or find inverse. However once we remember the hot-key or function-call for each operation, we don’t really need these toolbars. Using hot-key or function-call is a much quick way to invoke the menu selection.

For example, to find inverse of an given matrix \( A \), we only need to type \( A^{-1} \) (which will show as \( A^{-1} \) in the workplace) and = (which tells Mathcad to execute the operation) to find it.

1.1.3. **Evaluation Toolbar.** The **Evaluation Toolbar** contains tool-

![Evaluation Toolbar](image)

**Figure 7. Evaluation Toolbar**

bar for assignment operator :=, global definition operator \( \equiv \), and the evaluation command =.

Notice in Mathcad, equal sign = is used as evaluation command that tells Mathcad to carry out the computation. There are two execution mode, one is **automatic**, in this mode, Mathcad carries out execution when we press \( [=] \); another is **manual**, in this mode you will have first press \( [=] \) followed by \([F9]\) key to let Mathcad to carry out the execution. The manual mode is desirable when we want to delay the execution and don’t want to be bothered by many error message Mathcad would produce in automatic mode. You turn off/on the automatic mode from the **Math** menu on the **Main Menu bar**.
In the automatic execution mode, after we type \[3+2=\] we get 
\[3 + 2 = 5.\]

If we want to assign 2 to variable \(x\) we will have to type \(x:=2\), which will be displayed as \(x:=2\) in the work area. Therefore, a mathematical expression 
\[y = x + 3\]
will be enter differently according to the meaning of the expression,

1. Entering it as \(y:=x+3\) when \(x\) value has been defined before this expression and you want \(y\) to be the value of \(x\) plus 3, i.e. assign the value of \(x + 3\) to \(y\).
2. Entering it as \(y(x):=x+3\) when we want to set \(y\) as a function of \(x\) defined as \(x + 3\).
3. Entering it as \(y[\text{Ctrl}]=x+3\) when we like to compare \(y\) and \(x + 3\), i.e. to logically determine if \(y\) has the same value as \(x + 3\), here ‘[Ctrl]=’ mean enter ‘=’ while hold the ‘[Ctrl]’ key.

We can get the logic equal sign = from the Boolean Toolbar as shown below. Notice you also get ≤, ≥, ≠, and other logic operation from the Boolean Toolbar.

![Boolean Toolbar](image)

**Figure 8.** Boolean Toolbar

The global assignment operator \(\equiv\) (shortcut \(~\) ) is to assign an value (expression) to a variable (a function) so it can be referred in any place of the work area. The following screen shot illustrates the difference between =, :=, =, and \(\equiv\).
The reason behind these differences and using of $\equiv$ Mathcad is that scans your input from top to bottom and left to right as illustrated in the following diagram.

So a variable or a function must be defined before it is used. The $\equiv$ will give us a leverage to defy this scan order so we can define and use a variable (function) without worrying about the proper order demanded by the Mathcad as illustrated in the following two screen shots. Notice red font indicate an error.

1.1.4. Calculus Toolbar. The Calculus Toolbar as shown below allow us to perform computations found in Calculus. We will give detail description in later section about the symbolic computation using Mathcad.
1. INTRODUCTION TO Mathcad

1.2. The Insert Menu. The Insert menu, among other features, allows a user to insert a text region in the Mathcad work place or math region inside text region,

![Calculus Toolbar](image)

**Figure 9. Calculus Toolbar**

![Insert Menu](image)

**Figure 10. Insert Menu**

In side the text region, user can enter any text as she/he would do in a normal text editor with any format setting that can be specified through the Format->style menu. Another way to insert a text region is to type double quotation mark " Mathcad also allow a user to insert a math region inside a text region so users can insert a mathematical expression in the text region.
A third usage we are interested in the **Insert** menu is to insert a graphic region, a matrix, and a special built-in function. The following screen shot shows the case of inserting a matrix.

![Figure 11. Insert a Matrix](image1)

**1.3. The Symbolic Menu.** The **Symbolic** menu, allows us to carry out symbolic computation. We can factor polynomial, simplify an complex expression, find antiderivative, Laplace transform and inverse Laplace transform, etc.

![Figure 12. Insert Menu](image2)
The following screen shot shows the case of evaluating an expression symbolically.

Figure 13. Evaluate

Another screen shot to show finding Laplace transform symbolically.

Figure 14. Laplace Transform

Practice

(1) Find difference between \( = \), \( := \) (\([\text{Shift}];\), :), \( = (\{\text{Ctrl}\}[=] \) and \( \equiv (\{\text{Shift}\}[\sim \text{sign}]) \) with mathematical express \( y = x + 3 \).

(2) Define some matrix in you working area and place with Matrix toolbar.

(3) Place graph region in the work area, the typing something in the place hold \( \text{.} \).
1.4. Shortcut keystrokes. Besides using menus or popup menu toolbars to insert item into working place, we can (should) use shortcut keystrokes (or hot keys) to accomplish the same goals.

One important concept in entering expression in Mathcad is the place holder. It is a little dark rectangle box. For example, when you type $+$ (addition operator) in any blank area we get $a + b$. In the place holders we enter any valid mathematics expression.

Mathcad uses arithmetic operators $+, -, \times, \div, \wedge$ etc in the same way as standard calculator. The following table list the keystrokes for arithmetic operators, root operators, and subscription (indexing).

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Usage</th>
<th>Type</th>
<th>Display</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>$+$</td>
<td>add</td>
<td>a+</td>
<td>$a + b$</td>
<td>type an expression in $b$</td>
</tr>
<tr>
<td>$-$</td>
<td>subtract</td>
<td>a-</td>
<td>$a - b$</td>
<td>type an expression in $b$</td>
</tr>
<tr>
<td>$\times$</td>
<td>times</td>
<td>a*</td>
<td>$a \cdot b$</td>
<td>type an expression in $b$</td>
</tr>
<tr>
<td>$\div$</td>
<td>divide</td>
<td>a/</td>
<td>$a \div b$</td>
<td>type an expression in $b$</td>
</tr>
<tr>
<td>$\wedge$</td>
<td>power</td>
<td>a$\wedge$</td>
<td>$a^{b}$</td>
<td>type an expression in $b$</td>
</tr>
<tr>
<td>$\sqrt{}$</td>
<td>square root</td>
<td>a$\sqrt{}$</td>
<td>$\sqrt{a}$</td>
<td>type an expression in $b$</td>
</tr>
<tr>
<td>[Ctrl]$\sqrt{}$</td>
<td>$n^{th}$ root</td>
<td>Ctrl$\sqrt{}$</td>
<td>$\sqrt[n]{a}$</td>
<td>type index in the first $b$ and radicand in the second $a$</td>
</tr>
<tr>
<td>$[\ ]$</td>
<td>subscript</td>
<td>a$[\ ]$</td>
<td>$a_{b}$</td>
<td>type subscripts separated by $b$, in $a$</td>
</tr>
</tbody>
</table>

Since in mathematics $x = y$ has four different meanings,

1. definition: defines functions or notation, for example, in the expression $f(x) = x^2 + 1$, one defines a function $f$ by an expression $x^2 + 1$.
2. assignment: assigns value of $y$ to $x$; like in the sentence “set $x = y$...”.
3. logical equal: $x$ is equal to $y$ logically; like in the sentence “if $x = y$ ...”.
4. result of computation: like “$4 + 5 = 9$” here 9 is result of adding 5 to 4.

Mathcad uses $=$ as execution command, that is to tell Mathcad to compute the value. It uses $(:=)$ for assignment and definition, and (boldface $=$) for logic equal.
The following table list keystrokes for assignment plus relational operators.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Usage</th>
<th>Type</th>
<th>Display</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;&quot;</td>
<td>Entering text</td>
<td></td>
<td>&quot;&quot;</td>
<td>type any text in</td>
</tr>
<tr>
<td>;</td>
<td>assignment</td>
<td>a:3</td>
<td>a := 3</td>
<td>assign 3 to a</td>
</tr>
<tr>
<td>;</td>
<td>range variable</td>
<td>a:1;</td>
<td>a := 1 . . .</td>
<td>if enter 4 in a, a will have values 1, 2, 3, 4</td>
</tr>
<tr>
<td>[Shift][~]</td>
<td>global assignment</td>
<td>a ~ 3</td>
<td>a ≡ 3</td>
<td>assign 3 to a globally</td>
</tr>
<tr>
<td>[Ctrl][=]</td>
<td>logic equal</td>
<td>a: [Ctrl][=]1;</td>
<td>a = 1</td>
<td>a is logically equal to 1</td>
</tr>
<tr>
<td>&lt;</td>
<td>less than</td>
<td>a &lt;</td>
<td>a &lt;</td>
<td>type an expression in a</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
<td>a &gt;</td>
<td>a &gt;</td>
<td>type an expression in a</td>
</tr>
<tr>
<td>[Ctrl][9]</td>
<td>less or equal</td>
<td>a [Ctrl][9]</td>
<td>a ≤</td>
<td>type an expression in a</td>
</tr>
<tr>
<td>[Ctrl][0]</td>
<td>greater or equal</td>
<td>a [Ctrl][0]</td>
<td>a ≥</td>
<td>type an expression in a</td>
</tr>
<tr>
<td>[Ctrl][3]</td>
<td>not equal</td>
<td>a [Ctrl][3]</td>
<td>a ≠</td>
<td>type an expression in a</td>
</tr>
</tbody>
</table>

Table 2. Assignment And Relational Operators

The following table lists keystrokes to bring up derivative operators, integration operators and matrix operators.

<table>
<thead>
<tr>
<th>Keystroke</th>
<th>Usage</th>
<th>Type</th>
<th>Display</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Shift][/] (? )</td>
<td>derivative</td>
<td>[Shift][/]</td>
<td>( \frac{d}{dx} )</td>
<td>variable in at denominator and function in other</td>
</tr>
<tr>
<td>[Shift][Ctrl][/ ]</td>
<td>nth derivative</td>
<td>[Shift][Ctrl][/]</td>
<td>( \frac{d^n}{dx^n} )</td>
<td>index at two exponents variable in at denominator after d and function in last</td>
</tr>
<tr>
<td>[Ctrl][I ]</td>
<td>indefinite integral</td>
<td>[Ctrl][I ]</td>
<td>( \int dx )</td>
<td>integrant in first and integral variable in second</td>
</tr>
<tr>
<td>[Shift][7] (&amp; )</td>
<td>definite integral</td>
<td>[Shift][7]</td>
<td>( \int_a^b dx )</td>
<td>integrant in first and integral variable in after d</td>
</tr>
<tr>
<td>[Ctrl][M ]</td>
<td>add matrix</td>
<td>[Ctrl][M ]</td>
<td>A dialog box</td>
<td>specify rows and columns in the dialog box</td>
</tr>
<tr>
<td>[Ctrl][6 ]</td>
<td>get a row of a matrix</td>
<td>M[Ctrl][6]</td>
<td>( M^{\text{row}} )</td>
<td>specify row number in which is between 0 and rows(M)-1 inclusive.</td>
</tr>
</tbody>
</table>

Table 3. Calculus And Matrix Keystrokes
Practice

Start Mathcad and practice all shortcut keys (hot-key) listed in the four tables.

2. Basic Usage of Mathcad

One can use Mathcad as ordinary graphic calculator in doing arithmetic computing like $3 + 5 = 8$, defining and graphing functions such as $f(x) = 3x^2 + 3$. When perform arithmetic computation, you just need to click any blank area and enter the expression, then press = or = and [F9] key. The result will be immediately display. For example the following key strokes $\boxed{3+5=}$ will produce $3 + 5 = 8$ in the working area when aut-computation mode is on, or $3 + 5 =$ if the aut-computation mode is off. In later case, you will have to press [F9] key to generate the result.

The difference between = and [F9] is the following,

- = only evaluate expressions when the mode of execution is set to be automatic. If aut-computation mode is turn off, = will only create a \(=\) after the expression.

F9 causes Mathcad to carry out all computation in a given workplace. You will have to use [F9] to tell Mathcad to do computation if you turn off the automatic compute mode, which is desirable if you don’t want to be bothered by Mathcad warning message.

You can turn on/off the aut-computation mode through Math menu.

2.1. Some General Editing Methods. As in most window based text editors, we can use mouse to choose input starting point by moving mouse cursor to a desired point and click the right button.

Every Mathcad equation, text paragraph, and plot in a worksheet is a separate object called region. We can also use mouse to select several regions and drag them around.

To select one region, just move mouse over the region and click. A light bounding box will appear, which indicates the region is selected, as in the following screen shot for a selected math region,
and another screen shot for selected text region,

![Mathcad Professional - [Untitled.1]](image)

\[ f(x) = x^2 + 1 \]

\[ a = 1 \ldots 10 \]

**Figure 15. Select Text Region**

To select one or more regions on the screen, move the mouse to the starting point and hold down right button and move the mouse. A selecting box appears, any item inside the selecting box is surrounding by a dashed box as shown in the following screen shot.

![Mathcad Professional - [Untitled.1]](image)

**Figure 16. Select Multiple Locations**

After releasing the right mouse button, all regions selected items are bounded by dash box and the mouse cursor changes to a small hand. Click and hold mouse on any of selected region, you can move the selected regions to any wanted location. To deselect, simply click on any blank region outside the selecting box.

We can also select items inside each region. When we click a math region, we see a blue selecting line under the currently selected item. The blue selecting line has three different shape depends on where we click at in a math region. If we click at the beginning of the math region (or before a math operator like +, - ) etc.), the blue selecting line is look like \( \downarrow \); if we click at the middle of some text, the blue selecting line is look like \( \perp \); if we click at the end of the region (or after a math operator like +, - ) etc.), the blue selecting line is look like \( \uparrow \).

The following screen shot displays some of the cases,

By push **space bar**, we can increase number of item selected, arrow keys are used to change selection and shape of the blue selection line.

To select texts in a text region, we just click at any desired point inside the region, and either hold the right button down while dragging
2.2. Define Variables and Functions. As in all computational program, when a computation involving a variable of functions, the variable or function must be defined before its use unless the function is predefined in Mathcad. Mathcad predefines many functions, such as all trigonometric function, exponential function and logarithm function. The following table list most frequently used predefined functions.

<table>
<thead>
<tr>
<th>Function</th>
<th>Type</th>
<th>Display</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \sin(x) )</td>
<td>( \sin(x) )</td>
<td>( \sin(x) )</td>
<td>when type ( \sin(\pi) = ) you will get 0, since ( \sin(\pi) = 0 )</td>
</tr>
<tr>
<td>( \cos(x) )</td>
<td>( \cos(x) )</td>
<td>( \cos(x) )</td>
<td>when type ( \cos(\pi) = ) you will get -1, since ( \cos(\pi) = -1 )</td>
</tr>
<tr>
<td>( \tan(x) )</td>
<td>( \tan(x) )</td>
<td>( \tan(x) )</td>
<td>when type ( \tan(\pi) = ) you will get 0, since ( \tan(\pi) = 0 )</td>
</tr>
<tr>
<td>( \exp(x) )</td>
<td>( \exp(x) )</td>
<td>( \exp(x) )</td>
<td>this is exponential function, you can also type ( e^x ), you will get ( e^\pi ) in you can enter an valid expression</td>
</tr>
<tr>
<td>( \Phi(x) )</td>
<td>( F[\text{Ctrl}]g(x) )</td>
<td>( \Phi(x) )</td>
<td>Heaviside function defined by ( \Phi(x) = \begin{cases} 0 &amp; \text{if } x &lt; 0 \ 1 &amp; \text{if } x \geq 0 \end{cases} )</td>
</tr>
<tr>
<td>( \ln(x) )</td>
<td>( \ln(x) )</td>
<td>( \ln(x) )</td>
<td>natural logarithm function</td>
</tr>
</tbody>
</table>

2.2.1. Define Variables. There are two type variables in Mathcad, a normal variable which holds one value, and a range variable which, like vectors in math, holds multiple values. The variable name is any sequence of letters and digits that begin with a letter such as \( a, a1, bx12 \), etc. To define a normal variable you just click any clear region and type the name of the variable followed by \( : \), which bring up
the assignment operator :=, and followed by the numeral value. For example the keystrokes \[ x:23 \] defines a variable named \( x \) whose value is 23, which is displayed as \( a := 23 \) in the worksheet.

To define a range variable, usually an index variable, we use ‘;’, semicolon. The following table list several type of range variables,

<table>
<thead>
<tr>
<th>Variable</th>
<th>Type</th>
<th>Display</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>a:1;10</td>
<td>( a := 1..10 )</td>
<td>a takes values 1, 2, ..., 10</td>
</tr>
<tr>
<td>ax</td>
<td>ax:1,3;10</td>
<td>( ax := 1,3..10 )</td>
<td>ax takes values 1, 3, ..., 10, incremented by 2. Notice the user of ‘,’</td>
</tr>
<tr>
<td>ab1</td>
<td>ab1:0,.1;10</td>
<td>( ab1 := 0,.1..10 )</td>
<td>ab1 takes values 0, 0.1,0.2, ..., 10, incremented by 0.1.</td>
</tr>
<tr>
<td>ale</td>
<td>ale:10,9;1</td>
<td>( ale := 10,9.1 )</td>
<td>ale takes values 10, 9, ..., 1, decremented by 1.</td>
</tr>
<tr>
<td>ac</td>
<td>ac:10,9.8;1</td>
<td>( ac := 10,9.8..1 )</td>
<td>ac takes values 10, 9.8,9.6, ..., 1, decremented by 0.2.</td>
</tr>
</tbody>
</table>

Table 5. Mathcad Example of Range Variables

2.2.2. Define and graph Functions. To define a function in Mathcad is same as to write down a function in a piece of paper. You just type in the function name, followed by open parenthesis ( and the argument(s) that are separated by comma(,) and the close parenthesis ), then type the assignment operator – colon(:) followed by typing in the expression(formula) for the given function.

For example to define a function \( f(x) = 4x + 3 \), we would type \( f(x):4x+3 \), notice you don’t need to type the multiplication operator between 4 and \( x \) as Mathcad automatically insert it for you. However, if you want to define a function such as \( f(t, y) = 3t + ty \), you would need to specifically type in the multiplication operator \( * \), as shown, \( f(t,y):3t^2+t*y \)

also notice that we should type no space between terms as Mathcad will insert it for us when we type in a arithmetic operator. When typing in an expression involving more than one terms, space character serves as grouping operator. Hitting space bar will cause Mathcad to group term together. This is useful when entering expression like \( \frac{x+3}{3x-5} \), here we will need to group \( x + 3 \) together by press space bar before we type the division operator(/). Another usage of space is to move out the superscript or subscript mode. The following table gives several example to illustrate the usage of space. Notice, in order to move out
2. BASIC USAGE OF Mathcad

<table>
<thead>
<tr>
<th>Type</th>
<th>Display</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>x^2 + 3x</td>
<td>$x^2 + 3x$</td>
<td>No space is typed after ^ so Mathcad continue entering the expression as exponents.</td>
</tr>
<tr>
<td>x^2 + 3x</td>
<td>$x^2 + 3x$</td>
<td>A space is typed after ^ so Mathcad exists the power mode and enter 3x as another term.</td>
</tr>
<tr>
<td>x[2 + 3x</td>
<td>$x_2 + 3x$</td>
<td>No space is typed after [, the subindex operator so Mathcad continue entering the expression as subindex.</td>
</tr>
<tr>
<td>x[2 + 3x</td>
<td>$x_2 + 3x$</td>
<td>A space is typed after [, so Mathcad exists the power mode and enter 3x as another term.</td>
</tr>
<tr>
<td>x + 3/4x + 5</td>
<td>$x + \frac{3}{4x+5}$</td>
<td>No space is typed before / so Mathcad interprets as 3 divided by 4x + 5.</td>
</tr>
<tr>
<td>x + 3 /4x + 5</td>
<td>$\frac{x+3}{4x+5}$</td>
<td>A space is typed before / so Mathcad groups x + 3 and treats it as numerator.</td>
</tr>
</tbody>
</table>

Table 6. Mathcad Effect of Space Character

of the denominator, we need to press space too. For example, if we want enter $\frac{x+3}{4x+5} + 7x$, we would type in Mathcad as x+3 /4x+5 +7x that is entering one space after 3 and another space after 5 to move out the denominator. Play with the space character (space bar) to see if Mathcad can give us more surprises!

To find value of a function, such as $f(3)$, or $h(4, 2)$, you first define the function $f$ and $g$ and type $f(3)= $ or $h(4,2)= $, Mathcad will happily find the value for you.

To graph a function of one variable after defining it, just click any blank space after the definition of the function and type @ or from Insert menu choose to insert xy-plot. A box will appear with several placeholders. Enter the function name on the left center place holder and the variable on the bottom center place holder. If the variable name is not used before, the Mathcad will display a graph over default interval [-10, 10]. But if we has assign values for the variable, depending on how we assign value to variable, we might be surprised to find no curve
is displayed. That might be due to our variable only has one value, so only a dot is plotted. To see if this is the case, double click the graph box, a popup window will show, by specifying the thickness of the trace we will see the dot if it is graphed. Another reason we don’t see a curve is that the range for y is not properly specified. We can change the lower and upper limit for y variable by clicking the lower and upper left corners, place holders (or number) will appear, change it to the desired value, the graph will appear. So to graph a function, we do:

1. Define the function.
2. Define range value for the variable of your function.
3. Press @ and enter the function name and variable name in proper place holder.
4. Adjust the thickness of the trace.
5. Adjust the y ranges by changing the numbers on the far left (see the graph below).

We have two screen shots here, the first one shows a blanket graphing box with place holder and another graphing box display graph of $f(x) = \frac{1}{3}x(3 - x)$ over interval [-4, 4].

![Graph of one function and blank graphing box](image)

**Figure 18.** Graph of one function and blank graphing box

The second one shows how to graph more than one functions in the same graph box; it also shows the configuration box and change of the weight of the curve. To graph two or more functions in one graphing box, you just type comma (,) after each function name as $f(x), g(x), h(t)$. If two or more variable name (as in the case of screen cut) you need specify them in the place holder for variable comma separated as $x, t$. 
Figure 19. Graph of two function in one graphing box

Notice, in this second screen shot \( t \) has only one value 2, so the graph displayed as one point (green). We have changed the weight of the trace to 5 so the point is big green dot.

Mathcad is capable to display many type of graphs. In the later chapters we will learn how to plot 3-D graphs, such surface plot, contour plot, vector field plot, etc.

Practice

Start Mathcad program,

(1) Type the following expression in the work area
   (a) \( x + 3y \)
   (b) \( x^2 + 2x - 5 \)
   (c) \( e^{2x} \)
   (d) \( x^2 \cdot y^2 - x \cdot y / (2x \cdot y - 5) \), notice you need to hit space bar a few time to before you enter \(/\), so you get expression \( x^2 y^2 - x \cdot y \)
   (e) \( \sin(3x) e^x - t^3 e^{-2t} \)

(2) Define matrices \( A = \begin{bmatrix} 3 & 4 \\ -1 & 18 \end{bmatrix} \) by entering \( A : [\text{Ctrl}] [M] \) and choose 2 for row and column numbers, entering the numbers in proper place holder.
   (a) Find inverse of \( A \) by type \( A^{-1} \)
   (a) Find \( A \begin{bmatrix} 2 \\ 4 \end{bmatrix} \) by entering \( A \begin{bmatrix} 2 \\ 4 \end{bmatrix} [\text{Ctrl}] [M] \) and set row=2 and col=1 in the dialog box, entering the number then press \( = \).
   Define \( b = \begin{bmatrix} -2 \\ -5 \end{bmatrix} \), and find \( A b \).

(3) Define the following functions
(a) \( f(t) = 2t - e^t \)
(4) (b) \( f(t, x) = t^2 - 4t \sin(x) \)
(5) (c) \( f(t, x) = \frac{2t - e^x}{2tx - \cos(x)} \).
(6) Graph function \( f(t) = t^2 - 2t - 1 \)
(a) without specifying value for \( t \).
(b) define \( t = 0, 0.1 \cdots 5 \)
(c) Graph \( g(t) = 4 \sin(t) \) in the same chart.
(d) Graph a point \((4, 5)\) in the same plot, now you need put \(t, t, 4 \) in the bottom place holder and \( f(t), g(t), 5 \) in the left middle place holder. You also need to double click the graph and change the weight so the point is shown as in the following screen shot.

Project
At beginning you should enter: Project title, your name, ss#, and due date in the following format

**Project One: Define and Graph Functions**

John Doe
SS# 000-00-0000

Due: Mon. Nov. 23rd, 2003
You should format the text region so that the color of text is different than math expression. You can choose color for text from **Format**–>**Style** select normal and click **modify**, then change the settings for font. You can do this for headings etc.

(1) **Define and Graph functions**
In the project you will do:
- Define $f(x) = (x - 3)(x - 1)(x + 2)$
  Define a range variable $x = -5, -4 \cdots 5$ and find function value at range variable.
- Find zero of its derivative by perform the following task,
  [-] define $df(x)$ with input $df(x): [\text{Shift}] [/]$ and enter $f(x)$ and $x$ in the place holder so you have $df(x) := \frac{d}{dx}f(x)$.
  [-] Type keyword **Given**, entering $df(x) [\text{Ctrl}] [=]$ in next line, and keyword **Find** following by $(x)$, then press $[\text{Ctrl}][.]$
  [-] Find zeros of its second derivative.
- Determine intervals where the function is concave upward and concave downward. Type your explanation in text regions.
- Graph the function, its first derivative, and second derivative in the same plot. Explain the relationship between the signs of its derivatives and concavities of its graph.

(2) **Matrix Calculation**
Define the matrix $A = \begin{bmatrix} 3 & -2 & 4 \\ -1 & 2 & 1 \\ 5 & -8 & 22 \end{bmatrix}$
- Find determinant of $A$ by type $|A|$, notice when you type $|$ you will get $|s|$ and in $\text{enter } A$.
- Find inverse of $A$.
- Find the solution of the following system of equation
  \[
  \begin{align*}
  3x_1 - 2x_2 + 4x_3 &= 1 \\
  -x_1 + 2x_2 + x_3 &= 3 \\
  5x_1 - 8x_2 + 22x_3 &= 11
  \end{align*}
  \]
  by computing $A^{-1}b$ where $b = \begin{bmatrix} 1 \\ 3 \\ 20 \end{bmatrix}$ Solve the same system of equations by
  [-] Enter keyword **Given**,
[-] entering
\[
3x - 2y + 4z = 1 \\
-x + 2y + z = 3 \\
5x - 8y + 22z = 11,
\]
notice, you use [Ctrl][=] to enter the logic equal sign =.

[-] Enter keyword **Find** following by \((x, y, z)\), then press [Ctrl][.]

- Compare the solution obtained in above two steps, do see any difference? and why? You should enter your observations in text region (created by enter double quotation ”).
- Double click the result of \(A^{-1}b\) and change the display to fraction.
- Define three functions:
  \[
  M1(x, y) = -\frac{3}{4}x + \frac{1}{2}y - \frac{1}{4} \\
  M2(x, y) = x - 2y - 1 \\
  M3(x, y) = -\frac{5}{22}x + \frac{4}{11}y - \frac{1}{2}
  \]
  and graph them in a 3-D plot. You can use [Shift][Ctrl][2] to create a 3-D plot region and in the place holder, enter M1,M2,M3.
- Rotate the graph by click at the region and hold right mouse while moving it so the intersection is clearly seen.